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1 Introduction 
 
 

OMEX DATA2000 is a data analysis package designed to be used in conjunction with OMEX ECUs. 

DATA2000 offers many advanced analysis features including overlays, histograms, XY plots, maths 

channels, lap analysis, and channel alarms. DATA2000 runs on most PCs under all current versions 
of Windows operating systems Win95 - XP. 

 
 

1.1 Documentation 
 

Throughout this guide, procedures in DATA2000 are referred to using the menu commands 

separated by a | symbol. Thus File | Open means select the Open command from the File menu. 

 
A comprehensive on-line help system is provided with DATA2000 to give more details on using the 

package. To view the help, press F1 or select Help | Help Topics. 

 
Help can also be obtained in dialog boxes by clicking on the ? in the top right hand corner of the box 
and then clicking on the item for which you require help. 
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2 Installing DATA2000 

 
 

DATA2000 is supplied on 3½” floppy disk with MAP2000. When MAP2000 is installed, DATA2000 
will also be automatically installed. 
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3 Creating Log Files for use with DATA2000 
 
 
DATA2000 is the software with which log files are read. These log files can be created by PC based 
logging, where a laptop computer is connected to the ECU, or by ECU based logging using the 
ECUs internal memory (only currently available on the 700 series ECUs). Please refer to the 
MAP2000 manual and the 700 series hardware manual for instructions on how to create these files. 
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4 Menu Commands 
 

The following section gives a brief overview of the menu commands and their use. If a tool bar 
button or a keyboard shortcut can be used to perform the same function, it is shown in the left hand 
margin. 

 
 

File Menu 
 
The File Menu contains all the commands used for file management: 
 

Open - Use the open command to open a log file. 
 

Reopen - Allows a file to be selected from the most recently opened log files. The down arrow next 
to the open button can also be used to reopen files. 
 

Export - Exports data in an ASCII format suitable for use in other applications such as word 
processors or spreadsheets. 
 

Abstract - Copies selected channels into a new data file. 
 

Notes - Displays notes about the current data file and allows new notes to be added. 
 

Exit - Quits DATA2000. 

 
 

Graph Menu 
 

The Graph Menu contains commands used for displaying and printing graphs. 

 
Graph - Invokes the graph options editor where the number of lines, overlays and lap markers can 
be specified.  

 
Overlays - Allows the graph overlays to be set. 
 

Setup - Edit edits the setup of the currently active graph. (Note that this is different from the 

currently active setup). Update Log File saves any changes made to the data file. 
 

Shift Overlays - Allows the x axis of any overlayed Files to be moved relative to the base graph x 
axis by dragging the plot. When in shift mode, the cursor will change to a . Click on the graph 
and drag the overlayed plots to a new position. 
 

Zoom - Allows zooming in or out on the x and y axes. 

 In Zooms in the x axis. 

 Out Zooms out the x axis. 

 Expand Zooms in the y axis. 

 Contract Zooms out the y axis. 

 Normal Resets all zooms. 
 

Plot Types –  

 Time or Distance: Plots the graph against time or distance (if recorded). 

 Real or A-D: Plot the graph using real (engineering) units or using raw 8 or 16 bit data. 

 Standard Plot or Lap Plot: Allows the lap plot facility to be switched on. 
 

Tape Measure - Displays the Tape Measure window. This allows the difference between two points 
on a graph to be measured. 
 

Insert Marker - Inserts a Custom Marker at the current position. 
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Analysis Menu 
 

The Analysis Menu contains commands for examining the data in more detail than possible via a 
simple graph. 

 
Lap Times - Use to display lap markers, split, total lap times and average lap speed. 
 

Statistics - Displays minimum, maximum and average values of channels. Double clicking on a 
minimum or maximum value will automatically zoom the graph around that point. 
 

Histogram - Shows the frequency of occurrence of values in a channel as a percentage of the 
current zoom range time or distance. 
 

XY Plot - XY plots allow one channel to be plotted against another thus allowing the relationship 
between the two channels to be explored. 
 

 
 

Alarms Menu 
 

Channel alarms can be used to alert users if data in a channel exceeds a predefined limit. Alarms 
can also be set to be conditional on two channels exceeding their limits. A maximum of 100 alarms 
can be set. A setup file must be loaded before Alarms can be edited. 
 

Create - Creates a new alarm file. 
 

Open - Opens an existing alarm file. 
 

Edit - Edits the current alarms list. 
 

Save - Saves the current alarm list. 
 

Show for Current - Displays any activated alarms for the currently loaded log file 
 

Active On Read - When checked, any activated alarms will be displayed when a card is read. 
 

Active On Open - When checked, any activated alarms will be displayed when a log file is opened. 
 

 

Templates Menu 
 

Graph templates allow frequently used graph plots, graph types and window positions to be saved. 
These can then be recalled at any time by running the template from the menu or by assigning a 
button on the toolbar to the template and clicking on the button 
 

Save - Saves the current screen layout and graph options as a template. 
 

Run - Prompts for a template file name and then runs the specified template. 
 

Configure - Configures toolbar buttons for use with saved templates. 
 
 

Config Menu 
 

Logger - Specifies the type of logger DATA2000 is being used with. The logger type affects certain 
areas of the setup editor. 
 

Options - Allows options such as graph colours to be set. 
 

Tool Bars - Some or all of the tool bars can be turned off if desired. 
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Close On Read - When checked, all existing data files will be closed when a new file is read from a 
card. This can be useful during a logging session that may result in the potentially confusing situation 
of many windows being open at once. Opening files will not force other windows to close. When not 
checked, existing files remain open when a new file is read from a card. 
 

Notes On Read - When checked, the user will be prompted to enter notes about the data file 
whenever a new file is read from a card. 

 
 

Window Menu 
 
Tile Vertically - Arranges windows vertically with all windows visible if possible. 
 

Tile Horizontally - Arranges windows horizontally with all windows visible if possible 
 

Cascade - Arranges windows in a cascaded format with each window on top of the previous one. 
 

Minimise All - Minimises all windows. 
 

Arrange - Arranges iconized windows. 
 

Close - Closes the active window. 
 
The numbered list at the foot of the Window menu can be used to make the desired window active. 
 
Cascaded windows appear on the screen diagonally, from upper left to lower right, overlapping so 
that the title bar of each window remains visible. 
 
Tiled windows are distributed to each corner of the screen, so that each window is visible and none 
overlap. 
 
Icons (or reduced windows) appear at the bottom of the DATA2000 main window. Each icon remains 
visible. Double-click an icon to make that window active. 

 
 

Help Menu 
 

Help Topics - Display the Help Topics dialog box: 
 

About - Display program version and serial number information. 

 
To find a topic in Help: 

 
 Click the Contents tab to browse through topics by category. 

 Click the Index tab to see a list of index entries: either type the word you're looking for or scroll 
through the list. 

 Click the Find tab to search for words or phrases that may be contained in a Help topic. 

 
Context sensitive help can be obtained by pressing the F1 key. 

 
Help can also be obtained in dialog boxes by clicking on the ? in the top right of the dialog box and 
then clicking on the item for which you require help. 
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5 Analysing Data 
 
 

Once a data file has been opened, data can be viewed and analysed by several means in 
DATA2000, each of which will be considered in detail below. 

 
 

5.1 Simple Graphs 
 

The simple graph allows channel data to be plotted against time or distance (if recorded). A typical 
graph screen is shown below: 

 
 

 
 
 
 
 

To alter the graph settings, commands from the graph menu are used. Many of these commands 
are reproduced in the graph popup menu. To view this menu, right click on the graph itself. 

 

If the graph is in 
overlay mode, 
clicking on the y 
axis cycles 
through all the 
axes scales for 
that plot 

Placing the 
mouse over a 
marker will show 
the time and date 
when the marker 
occurred 

Allows scrolling 
through a 
zoomed in 
graph 

Shows current 
graph settings 

Moving this bar 
changes the size of the 
values are and 
changes the font size 
as necessary 

Shows values 
of each 
channel at 
current cursor 
position 
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To change the lines plotted, choose Graph | Graph and the graph setup editor will be shown: 

 

 
 
 

Overlays can also be added from here by clicking the overlay button. Overlayed channels can be 
from either the existing file or from additional externals files. Up to four external files can be added; 
when plotted, overlayed channels from external files are preceded with a number corresponding to 
the file number in the overlay list. 

 
Overlays from external files can be shifted relative to the base graph by selecting Graph | Shift 

Overlays. This allows starting points of data to be easily synchronised. 

 
To zoom in on the graph to view the data in more detail: 
Keypad + 

 Select Graph | Zoom | In. The cursor will change into a  showing that you are in x axes 
zoom mode. 

 Click on the area of the graph where you want the zoom to start. 

 Click on the area of the graph where you want the zoom to end. The graph will be redrawn with 
the new zoom range. 

 The selected zoom range is bounded by red vertical lines at the start and end. Using the scroll 
bar at the bottom of the graph, data outside this zoom range can be viewed. 

 If there is data outside the scrollable region, a  or  will be shown at the edge of the scrollable 
area. These will shift the zoom area to the left or right respectively. 

 To zoom out to the previous zoom level, select Graph | Zoom | Out. (Keypad -) 

 The y axis can be zoomed in a similar manner by selecting Graph | Zoom | Expand which will 

change the cursor to to show that you are in y axis zoom mode. (Ctrl Keypad +) 

 To contract the y axis to the previous lever, select Graph | Zoom | Contract. (Ctrl Keypad -) 

 
The right hand side of the graph shows the values at the current position (shown on the graph by a 
vertical black line). This position marker can be moved by clicking the left mouse button on the graph 
and dragging the bar whilst still holding the mouse button down. Alternatively, the left and right cursor 
keys can be used (holding the shift key down whilst pressing the cursor keys will move the bar ten 
times as fast). 

 
Clicking the right mouse button on the values area of the graph will show a menu allowing line 
colours, style and y axis limits to be changed. This menu can also be used to add boundary lines for 
highlighting ranges on the graph. 

 
The y axis labels of the graph show the real or raw ranges of the graph. If a particular plot has 
overlays, the axis limits will show the current percentage range. By clicking on the y axis, the y axis 
labels will cycle through all actual channel limits for that plot. 

 
The functions available from the Analysis menu will now be considered. 

 

 

Sets the 
number of 
distinct areas 
plotted on the 
graph 

Allows overlays 
to be specified 
with the overlay 
setup editor 

Set the channels 
to be plotted 
here 

Click the draw 
button to draw 
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5.2 Statistics 
 

The statistics screen displays the minimum, maximum and average values of all channels in the 
base graph over the current zoom range and the times at which these occur. Double clicking the 
mouse on the time at which a minimum or maximum value occurs will zoom the graph in around this 
point. An example statistics screen is shown below: 

 
 

 
 

 

5.3 Histograms 
 

Histogram shows the frequency of occurrence of values in a channel as a percentage of the current 

zoom range time or distance. Choose Analysis | Histogram to show the histogram setup editor: 

 

 
 

Set channel to the channel for which the histogram is to be calculated. Conditions can then be 
applied to the histogram to limit the amount of data included by checking the When box and entering 
the condition desired. Up to three conditions can be specified and are combined with the logical 
operators AND, OR, NOT. Only values that meet the specified criteria will be included in the 
histogram. The number of bars to plot and the bar ranges can now be specified. 

Channel for which 
the histogram is to 
be calculated 

Condition which 
must be met for 
a value to be 
added to the 
histogram 

Additional 
conditions 

Number of bars 
the histogram is 
to be split over 

Set whether the 
bar ranges are 
to be calculated 
automatically or 
specified 
manually 

Sets the start 
and end bar 
ranges if in auto 
range mode 
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Once the setup is complete, click OK and the histogram will be drawn: 

 

 
 

Once a histogram is drawn, the histogram editor can be re-entered by right clicking on the histogram. 
Once a histogram setup has been created it can be saved to a histogram template by clicking the 
Save button in the histogram editor. Histogram templates can be assigned to buttons in the 

histogram editor  by selecting Config | Options and entering the filename in the histogram buttons 
page. 

 

 

5.4 XY Plots 
 

XY plots allow one channel to be plotted against another thus allowing the relationship between the 

two channels to be explored. To create an XY plot, choose Analysis | XY Plot; the XY plot editor will 
be shown: 

 
 

 

Channel to be 
used for the X 
axis 

Channel 
conditions 

Channel to be 
used for the Y 
axis 
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Set the X and Y channels for which the XY plot is to be draw. Conditions can then be applied to the 

plot to limit the amount of data included by checking the When box and entering the condition 
desired. Up to two conditions can be specified and are combined with the logical operators AND, 
OR, NOT. Only values that meet the specified criteria will be included in the XY plot. 

 
The point size changes the size of the plotted points. On plots using a large amount of data, a small 
point size should be used. However, when the data set used is small, a larger point size helps to 
show any trends in the data 
 
Once the setup is complete, click OK and the XY plot will be drawn. 

 
By clicking and holding the left mouse button on the graph, the mouse can move the cross hairs on 
the plot. The X and Y values at the current cross hair position are shown in the status bar at the foot 
of the graph. 

 
Once an XY plot is drawn, the XY plot editor can be re-entered by right clicking on the plot. XY plot 
settings can be saved in an XY plot template by clicking the Save button in the editor. XY templates 

can be assigned to buttons in the editor  by selecting Config | Options and entering the filename in 
the XY plot  buttons page. 
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6 Channel Alarms 
 

 
Channel alarms can be used to alert users if data in a channel exceeds a predefined limit. Alarms 
can also be set to be conditional on two channels exceeding their limits. A maximum of 100 alarms 
can be set. A setup file must be loaded before Alarms can be edited. 

 
 

6.1 Creating/Editing Channel Alarms 
 

To create/edit channel alarms: 

 
 Choose Alarms | Create to create a new alarm list or Alarms | Edit to edit the current alarms 

list. The Alarms editor will be invoked. Enter the desired alarm parameters in the relevant 
columns: 

 Alarm Name - A 12 character name for the alarm. 

 Channel - The channel to which this alarm will apply. The channel names are obtained from the 
currently loaded setup. 

  <> - If > is specified, the alarm is activated if the Limit is exceeded. If < is specified, the alarm is 
activated if the channel value falls below the Limit. 

 Limit - The numerical value of the limit. 

 With - Specifies if another channel limit has to be exceeded to activate the alarm. If NONE is 
specified, the alarm is based on the preceding parameters only. If AND, NOT or OR are 
specified, the first Channel <> Limit sequence is combined with the second Channel <> Limit 
sequence with the specified logical operator. 

 Click the Add button or Insert key to add a new alarm. 

 Click the Remove button or Delete key to remove the currently selected alarm. The arrow keys 
can be used to navigate around the alarms grid. When the desired item is highlighted, pressing 
the space bar allows it to be edited. Pressing the Enter key returns to navigate mode. 

 When the alarms have been created as desired, save them using Alarms | Save. 

 
 
Example 

 
Alarm Meaning 

Water Temp > 110 Activated if the water temperature exceeds 
110 

 
 

6.2 Using Channel Alarms 
 

Once the channel alarms have been created as desired, they can be used as follows: 

 
 Select when to show any alarms:  

 If Alarms | Active On Read is checked, any alarms activated will be shown when a card is read. 

 If Alarms | Active On Open is checked, any alarms activated will be shown when a log file is 
opened. 

 Alarms | Show for Current can be used to show alarms for the currently active data file. 

 
The last loaded alarm file will automatically be loaded on starting DATA2000. A newly created set of 
alarms must be saved before it can be used as the default alarm list. 

 
If any alarm limits are activated, the alarm report will be shown. This shows the alarm activated, the 
time at which it was initially activated and the duration for which it was activated. The minimum and 
maximum values of the main alarm channel over the alarms’ duration will also be shown. By double 
clicking on the alarm, the graph will be automatically zoomed in around the initial alarm occurrence 
point. 
 


